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Újrakonfigurálható eszközök

9. Cypress PSOC 5LP prototípus kártya
- az első lépések
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Felhasznált irodalom és segédanyagok

 Cypress: CY8C58LP FamilyDatasheet 

 Cypress: PSOC 5LP Architecture Technical Reference Manual)

 Cypress: CY8CKIT-059 Prototyping Kit Guide

 Cypress: AN777759: Geting Started with PSoC®5LP

 Cypress: PSoC®Creator™ User Guide

 Yuri Magda: Cypress PSoC 5LP Prototyping Kit Measurement 
Electronics

 Cserny István: PSOC 5LP Mikrokontrollerek programozása

http://www.cypress.com/file/45906/download
http://www.cypress.com/file/123561/download
http://www.cypress.com/file/157971/download
http://www.cypress.com/file/41436/download
http://www.cypress.com/file/137441/download
https://sites.google.com/site/icserny/home/2013fall/2013syllabus
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Cypress PSOC mikrovezérlők
 PSOC = Programozható System-on-chip  (CPLD + 

mikrovezérlő)

 PSoC 1: M8C (8-bites) 

 PSoC 3: 8051 (8-bites) 

 PSoC 4: ARM Cortex-M0 (32-bites) 

 PSoC 5LP: ARM Cortex-M3 (32-bites) 

 PSOC 6: ARM Cortex M4F + M0+ + BLE (32 bites)

 Fejlesztői környezet:

 PSOC Designer – csak PSOC 1-hez

 PSOC Creator – PSOC 3, 4, 5, 6-hoz

 A PSOC4 és PSOC5 mikrovezérlők 
3,3 V-os és 5 V-os tápfeszültségen is működhetnek!

A számtalan fix funkciós periféria 
mellett az univerzális digitális 
blokkokból egyedi perifériákat, 
vagy kiegészítő logikai 
áramköröket is kialakíthatunk.
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MCU és PSOC – mi a különbség?
 A hagyományos MCU központi eleme a CPU

 A PSOC esetében a CPU nem központi eleme az adatáramlásnak: 
a digitális és analóg perifériák és a kivezetések egy jól 
konfgurálható jel- és adatbusz mátrix hálózaton keresztül 
kapcsolódnak össze
 
MCU                                                PSOC  
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PSOC 3, PSOC 5LP rendszerszintű vázlat
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Tápellátás és tápfeszütségek
Standard tápellátási konfiguráció
• Nincs használatban boost töltéspumpa
• Vdda Vddd >= Vddio0/1/2/3
• Vdda = 1.8 – 5.5V
• Tápellátási szabályok

• Vdda: Ez legyen a rendszerben a 
legmagasabb feszültség. Ellátja a 
magasabb feszültségű analóg domént és 
a belső stabilizátorokat.

• Vddd: A digitális rendszer belső 
stabilizátorait táplálja.

• Vcca: Az analóg rész belső  
stabilizátorának kimenete.  Egy külső1.3 
uF szűrőkondenzátor kell rá a föld felé.

• Vccd: A digitális rész belső  
stabilizátorának kimenete.  Egy külső1.3 
uF szűrőkondenzátor kell rá a föld felé. A 
két Vccd kimenetet össze kell kötni, s egy 
közös 1.3 uF szűrőkondenzátoron 
osztoznak. 

• Vddio0/1/2/3: Független I/O 
tápfeszültségek.  Tetszőleges értékűek 
lehetnek 1.8V és Vdda között.
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Univerzális digitális blokkok (UDB)
 Az Univerzális Digitális Blokkokból a CY8C4245 PSOC 4 

mikrovezérlők 4 db-ot, a CYC8C5868, illetve CYC8C5888 PSOC 5LP 
mikrovezérlők 24 db-ot tartalmaznak.
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Egy univerzális adatblokk felépítése
 Az univerzális adatblokk 2 db 12 bemenetű és 4 makrocella 

kimenetű szorzat-tag előállító áramkört és egy regiszterekkel, 
illetve ALU egységgel ellátot „adatút” modult tartalmaz.
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Egy 12C4 PLD blokk felépítése
 PLD blokk jellemzők:

 12 bemenet

 8 szorzat tag (product term)

 4 makrocella kimenet

 TC = True vagy Complement

 AND = logikai ÉS kapuk

 OR = logika VAGY kapuk

 MC = makrocella
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Egy makrocella felépítése
 A makrocella működhet regiszterként vagy kombinációs logikai 

áramkörként
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Adatút (Data path)
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PSOC 5LP fejlesztőeszközök

CY8CKIT-050 PSoC® 5LP Development Kit 

CY8C5868AXI-LP035 (100 pin TQFP)
USB/DMA/12-bit SAR és 20-bit delta-sigma ADC
24 UDB (digitális blokk), 4  analóg blokk

CY8CKIT-059 PSoC® 5LP Prototyping Kit
CY8C5888LTI-LP097 (68 pin QFN)

USB/DMA/12-bit SAR és 20-bit delta-sigma ADC
24 UDB (digitális blokk), 4  analóg blokk
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CY8CKIT-059 fejlesztői kártya
USB csatlakozás
a PC-hez

KitProg programozó és 
hibavadász

PSOC 5LP
Target áramkör

USB – UART
Kivezetések

C8C5868LTI-LP039

LED1 (2.1 kivezetés)

SW1  (2.2 kivezetés)

CY8C5888LTI-LP097

JTAG csatlakozás

RESET  gomb helye

USB alkalmazói csatl.

A tápellátás történhet a 
programozó felől (5V),
Az alkalmazói USB 
csatlakozóról (5V), 
vagy a VDD 
csatlakozáson 
keresztül (3,3 – 5 V).

Utóbbi esetben  a D1 
és D2 diódákat el kell 
távolítani az USB-re 
csatlakozás előtt!
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A céláramkör kapcsolási rajza
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Fejlesztői szofver letöltése és telepítése
 Az alábbi szofverek némelyikének letöltéséhez ingyenes 

regisztráció szükséges a www.cypress.com webhelyen!

 PSOC Creator 4.1  (link: www.cypress.com/psoccreator)

 CY8CKIT-059 Kit Only – Kit tervezői fájlok, Dokumentáció, 
mintaprojektek (link: www.cypress.com/cy8ckit-059)

 PSOC 5 Programmer 
(link: www.cypress.com/products/psoc-programming-solutions)

 A fenti szofverek letöltése és használata ingyenes!

http://www.cypress.com/
http://www.cypress.com/psoccreator
http://www.cypress.com/cy8ckit-059
http://www.cypress.com/products/psoc-programming-solutions
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PSOC Creator indítása, Blinky projekt
1. Projekt Felfedező    2. Tervezőablak   3. Könyvtári modulok listája

  Projekt megnyitás:  File → Open → Project/workspace, majd betallózás

(de UDB is lehet)
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A Blinky projekt konfigurálása

Beállítások:

1. Fixed function vagy UDB

2. 8-bites mód

3. Egy kimenet

4. A periódus 100 órajel (1 s)

5. A kitöltés 2 órajel

6. Less or Equal mód

7. Holtsáv nem kell

Az Advanced lapon engedé-

lyezzük a Kill funkciót! 

 A CY8CKIT-059 kártya első mintapéldáját (CE957352 Blinking 
LED) egy kicsit átszabjuk a PWM_1 modul átkonfgurálásához. 
Ehhez duplán katintsunk az alkatrészre!
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Kivezetések hozzárendelése
 A K1 nyomógomhoz (Kill_Switch) a P2[2] kiveztés tartozik

 A LED1 kijelzőhöz (PWM Out) a P2[1] kivezetés tartozik

Ezeket a 
programozó 
lefoglalja
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A főprogram
 A PSOC eszközök esetén a hardver működtetéséhez a 

mikrovezérlőnek is futnia kell (órajelek generálása, 
modulok engedélyezése, stb.), ezért legalább egy  minimális 
méretű main.c  programra szükség van.

 A projektbe beillesztet könyvtári alkatrészek/modulok kezelését 
biztosító API függvényeket a PSOC Creator automatikusan 
beilleszte a projektbe, ezeket hívhatjuk meg a főprogramból 

A Blinky projekt main.c programjának listája

#include "project.h"

void main() {

    PWM_1_Start();     // PWM modul indítása    

    for (;;) {}

}
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Fordítás, programletöltés
 A projekt generálálás, lefordítás és letöltés lépései:

1) Az alkalmazás generálása (API generálás)

2) A projekt lefordítása (build)

3) Dokumentáció generálás (opcionális lépés)

4) A program letöltése (az áramkör csatlakoztatása után)
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A Blinky program futatása

LED1

             K1
Lenyomva tartva 
szünetel LED1 villogása
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Új projekt létrehozása lépésről-lépésre
 A következőkben egy új PSOC Creator projekt létrehozásának 

menetét mutatjuk be, lépésről-lépésre

 Az új projektünkben a PSOC 5LP mikrovezérlő UART porton 
kommunikál a PC-vel, s egy terminálablakból küldöt 
parancsokkal állathatjuk be a LED1 fényerejét

 Az UART kommunikáció a kártyánkra építet KitProg eszköz 
segítségével történik, mivel az USB-UART átalakítóként is 
működik

 A LED1 teljesítményét egy PWM modul segítségével 
szabályozzuk, s a PWM jel kitöltését szabályozhatjuk 5 – 95 % 
közöt

 A projekt forrása Yury Magda könyvének (Cypress PSoC 5LP 
Prototyping Kit Measurement Electronics) első mintaprojektje
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Új munkaterület létrehozása
 A munkaterület (workspace) egy vagy több projektet tartalmazhat

 Új munkaterület létrehozásának lépései a PSOC Creator-ban:

 File → New → Project menüpont választás

 Workspace választás, majd Next gombra katintás

 Munkaterület neve (pl. Lab01)  és  hely megadása, majd Finish
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Új projekt létrehozása 
 Jobb gombbal katintsunk a munkaterület nevére a 

Project Explorer ablakban!

 Válasszuk az Add → New Project menüpontot!
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Új projekt létrehozása
 A felbukkanó ablakban válasszuk a Target kit opciót és a 

CY8CKIT-059 eszközt, majd katintsunk a Next gombra!

 Válasszuk az Üres (Empty) opciót, majd Next!!!!

 Adjuk meg a projekt nevét (PWM_UART), majd Finish !!!!
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A kapcsolás megrajzolása
 A kapcsolás összeállítása a TopDesign.cysch lapon történik

 Az alkatrészeket a jobboldali menüből tallózhatjuk és húzhatjuk rá 
a rajzfelületre

 PWM_1:  Cypress → Digital → Funcions → PWM [v3.30]

 UART_1: Cypress → Communications → UART [v2.50]

 Clock_1:  Cypress → System → Clock [v2.20]

 0: Cypress → Digital → Logic → Logic Low ”0” [v1.0]

 PWM_Out: Cypress → Ports and Pins → Digital output pin [v2.20]

 Az összekötésekhez a     eszközt használjuk!

 A mikrovezérlőhöz kapcsolódó külső áramköri elemeket az 
Of-Chip  alkatrészkönyvtárból keressük ki! Ezeknek az 
elemeknek nincs hatása a projektépítésre illetve annak működésére, 
csupán dokumentációs célokat szolgál a tervrajz ilyen kiegészítése.
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Az áramköri terv
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PWM_1 konfigurálása
 Duplakatintással nyithatjuk meg a kiválasztot alkatrész 

konfgurációs felületét

 PWM_1: UDB, 16-bit mód, periódus=255, kitöltés=127, 
polaritás: Less or Equal, nincs holtsáv 
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UART modul konfigurálása
 Az UART_1 modullal full duplex kommunikációt valósítunk meg a 

KitProg-on keresztül ami USB-UART átalakítóként is szolgál

 Megzsakítást nem használunk, a sebesség 9600 bps, a formátum 
pedig 8 bit, 1 stop bit, no parity,  és nincs adatfolyam-vezérlés 
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CLOCK_1 konfigurálása
 A rendszer órajeleiből leosztással

további órajeleket képezhetünk

 A PWM_1 modulhoz 100 kHz-es
órajelet confgurálunk

 Azt UART_1 órajele automatiku-
san generálódik az adatsebesség
megadásakor
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A PWM_Out kivezetés konfigurálása 
 A PWM-Out kimenetel LED1-et akarjuk meghajtani, ezért „erős 

meghajtóként” (Strong drive) konfguráljuk

 A földre kötöt LED1-et így legfeljebb 4 mA-rel táplálhatjuk 
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A kivezetések hozzárendelése
 Mivel a külső áramkör kialakítása már adot számunkra, nekünk 

kell megadni, hogy mi melyik lábon legyen kivezetve
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Az órajelek konfigurálása

A „Design Wide Resources” Clock lapján a rendszer órajeleket konfigurálhatjuk (Edit 
Clock...-ra kattintva). Itt most ILO állítha elő a 100 kHz-es órajelet. A CPU 24 MHz-en fut. 
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A main.c program
#include <project.h>
#include <stdio.h>
#include <stdlib.h>
#include <string.h>
#include <ctype.h>
uint8 rxState; char buf[32]; char *pbuf = buf; int cmp;
int main() {
  CyGlobalIntEnable;         // Megszakítások engedélyezése
  UART_1_Start();            // UART_1 egység indítása
  PWM_1_Start();             // PWM_1 egység indítása
  for(;;) {
    pbuf = buf;
    UART_1_PutString("Enter duty cycle (5 - 95, max. 2 digits): ");
    UART_1_PutCRLF(0xD);
    UART_1_ClearRxBuffer();
    memset(buf, 0, strlen(buf));
    while (1) {
      if((rxState = UART_1_ReadRxStatus()) == UART_1_RX_STS_FIFO_NOTEMPTY) {
        *pbuf = UART_1_GetChar();
        if((isdigit((uint8)*pbuf) == 0) || (*pbuf == '\n')) {
          UART_1_ClearRxBuffer(); break; }
        UART_1_PutChar(*pbuf); UART_1_ClearRxBuffer(); pbuf++; }
    }
    UART_1_PutCRLF(0xD);
    CyDelay(500); cmp = atoi(buf);
    if ((cmp >= 5) && (cmp <= 95))
      PWM_1_WriteCompare((int)(cmp*2.56));
  }
}

Forrás: Yuri Magda: Cypress PSoC 5LP Prototyping Kit Measurement Electronics
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A projekt lefordítása és futatása
 A projektépítés munkamenete megegyezik a korábban leírtakkal 

(Build → Generate Application, Build → Build PWM_UART)

 A futatáshoz használhatjuk pl. a Termite programot, 9600 bps-re 
konfgurálva. A beírt számok 5 és 95 közötiek lehetnek!
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